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        Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave
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  Backup and Restore


  
    Dear Digital Dave,


    So I had to reformat my hard drive and reinstall my operating system, Windows 7. No sweat, I thought, as I back up everything online using Carbonite. I remember paying particular attention to getting my Windows Live Mail included in the backup. But when it came time to restore, there were no contacts in my address book.


    An hour spent with the Carbonite tech support returned the answer that Microsoft makes the address book a system file and excludes it from backups. So neither Carbonite nor I can find a trace of it. Have I really lost it all? Is this non-backing up of things a problem others fall prey to? Or is it that Carbonite should have been more specific in their instructions to paying customers?

    Gene Goldberg

    Santa Fe, NM

  


  
    Dear Gene,

    You may be in luck with your Windows Live Contacts. If you created an account with Windows Live when you installed Windows Live Mail, then there is a good chance that you will have all of your contacts. I recently installed Window Live Mail on another computer. Once I added my primary account to the program, it logged me into Windows Live Mail. All of my contacts were then available—even recently added contacts. You will only know if this will work for you when you reinstall Windows Live Mail. This is an incentive for every Live Mail user to sign up with Microsoft's Live service. Good luck.


    Your situation is one to the reasons that I advise installing robust local backup, even if you're using a Cloud service such as Carbonite. The backup tools in Windows 7 will back up the most common type of files (including e-mail) automatically. If you have your own second hard drive, as mentioned in the answer to John this week, then you would have a backup of your Carbonite backup. A system image would certainly have included your contacts.


    For even more protection—which would be backed up by Carbonite—periodically use the Export feature in Live Mail to create a separate file of your contacts saved in your Documents folder. Then you could later import the file when you lose everything.


    Digital Dave


  

  


  Solid State Drives and Laptop Batteries


  
    Dear Digital Dave,


    I know Solid State Drives (SSD) perform really well. The question is however, how do SSD affect laptop batteries?

    Mr. Carroll J Ware

    San Diego, CA

  


  
    Dear Mr. Ware,

    Since Solid State Drives have no moving parts, they easily outperform the spinning discs of their hard drive counter parts. The mechanical hard drive is the number one bottleneck in computer system speed. There is no doubt that the SSD, composed of flash memory, is the storage of the future. The only thing that had gotten in the way is the price—which continues to drop. However, even though there are no moving parts in the SSD, significant power savings from the SSD is a myth. In fact, in certain situations, battery operation times can be shorter.


    There have been numerous tests of SSDs compared to hard drives in laptop computers. Sometimes the battery charge will last 20 minutes longer with the SSD, but other times the results are significantly worse than the hard drive. The reason for this is the hard drives have been continually refined for power efficiency making then exceptionally low power mechanical devices. In operations such as video streaming which requires regular buffering, the hard drives often draw less power than an SSD. This seems counter intuitive, but the physics of the energy usage of the flash memory is more complex and harder to fix than the analysis of mechanical motion of a spinning disc with momentum.


    If you're getting a solid state drive for performance, then you're on the right track. If you want it to save extent battery operation per charge in a laptop, then you need to look elsewhere—at least for now.


    Digital Dave


  

  


  Windows 7 OS Partition Backup


  
    Dear Digital Dave,


    I just purchased a new machine with Windows 7, and was surprised to learn that the OS is not provided on a CD/DVD. Is there some way I can burn my own backup copy of the OS from the hard drive partition?

    John Danis

    Hooksett, NH

  


  
    Dear John,

    The primary reason for a disc copy of the Windows 7 operating system is just in case your hard drive becomes corrupted or crashes. It's easy enough to make a Windows disc, as discussed later in this answer. But maybe you would like a little more protection than you would get with a clean install which wipes out everything.


    Probably the best way to protect your Windows 7 computer system and recover from the dreaded hard drive crash is to create a System Repair Disc and a System Image through the Backup and Restore feature. The advantage of this approach is that you save more than just a copy of the Windows 7 System.


    Type "backup" in the "Search programs and files" field at the bottom of the Start Menu, then select Backup and Restore. In the left column of the window you will see "Create a system repair disc." This will create a bootable disc on a CD/DVD that will help to repair the system or recover from a system image. The advantage of the repair disc is that it is not a full Windows 7 installation and will fit on a recordable CD.


    The real key to recovering your computer is creating the system image. The system image includes all of Windows 7 plus the settings, programs, and all as of the date it was created. That means when you restore a system image you will get everything back as of that date and not need to install all of your programs. This takes considerably more space than a Windows 7 disc alone so you will want to save the system image to another device such as second hard drive. This is one of the reasons that I recommend a second or external drive regardless of any other backup solutions that are implemented. If you want to get really serious about protection get a two terabyte external drive. That way you can regularly backup system images, plus you will have portability.


    If you are looking for a way to get a clean Windows 7 install, whether for later use if something goes horribly wrong or for immediate use because the manufacturer puts a lot of irritating toolbars, ads, free trials and bloatware on a new PC, then you can make a Windows 7 disc by downloading the ISO file and burning it to a DVD-R. My Digital Life offers the Windows 7 ISO Direct Download Links. Microsoft has a free Windows 7 USB/DVD download tool which will burn the DVD (or USB drive) for you. You need to download the appropriate Windows 7 ISO file first.


    The first thing I do with a new work laptop is format the hard drive and install a clean version of Windows. A system restore disc would preserve all the manufacturer's cruft. Then later, after I've loaded my necessary programs and adjusting my setting, I can make a system image on my massive second hard drive for backup and protection.


    Digital Dave
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“Deciphering the madness of Windows 8” by Jack Dunning
      
    

  


  
    Whether you're an old-line Windows user or merely curious about what Microsoft is up to, here are some thoughts to help you understand the not yet released Windows 8 operating system.
  

  


  Over the last month I've spent a good deal of time playing with Windows 8 Consumer Preview and recording my thoughts. I've come to my conclusion—for now. My attitude started with a "Why is Microsoft doing this? Are they crazy?" frame of mind. I've now evolved around to "Aw, come on! It's not all that bad!"


  [image: ]I think that now I may understand the means in Microsoft's madness. There is a ton of misunderstanding about Windows 8—whether through confusion or deliberate misstatement. I'm not claiming that Windows 8 will be an outstanding success when it's released. There are too many factors outside of even Microsoft's control. However, I do think that it has a pretty decent shot to not only replace Windows 7, but give the Apple iPad a run for its money.


  I don't say this lightly. Although I use Windows on a couple of my computers, I'm not a huge Microsoft fan. I won't go near Microsoft Office as long as there is a free LibreOffice suite of programs available. I did not plan in advance to give Windows 8 a positive review. I like Windows 7 and don't see an immediate need to replace it. Also, I have tremendous respect for all those Windows XP users who avoided the Windows Vista fiasco.


  My initial reaction to Windows 8 was that it is merely Windows 7 with a tablet computer interface slapped on top of it. I thought that it would turn out to be another Microsoft kludge lumbering into the market. Plus, it looked like another Microsoft attempt to get Windows users to buy a new operating system yet again—which of course it is.


  Windows 8 Speed Tests


  My fear that Windows 8 would be a slow over-bloated hog turned out to be unnecessary. As mentioned by Digital Dave last week, those who have done benchmark tests have found that on the average Windows 8 runs 14 percent faster than Windows 7. Plus, Windows 8 boots up 35 percent faster than Windows 7. That alone will perk up the interest of Windows power users.


  When installed on a tablet computer (Acer Iconia W500), the new Windows 8 Metro User Interface (UI) runs the Peacekeeper Universal Browser Test faster than the Apple iPad 3. See "News and Reviews." I don't know how this will hold up by the time Windows 8 is released later in 2012, but it certainly shouldn't get worse.


  Misunderstandings


  There are a number of reasons why Windows 8 is misunderstood. The first is that the new opening screen, the Metro UI (see Figure 1), is so radically different from anything on previous editions of Windows that it's assumed that Microsoft is trying to force every Windows user into a new way of doing things. Microsoft is known for its heavy-handed tactics. It took us long enough to learn how to use Windows 7 (or Windows XP) without trying to change everything now.
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    Figure 1. The Windows 7 Metro Start screen uses tiles to launch apps and programs. Windows Desktop (circled in red), which launches and run Windows as we know it, is one of those tiles.

  


  There are a few "reviewers" who decided to run their own tests by sitting their parents (or in-laws) in front of the Windows 8 Consumer Preview to evaluate user-friendliness. The subjects suffered through the new interface while being videoed by the giggling reviewer. The tests may have come out differently if the victims had been given just one hint—the Windows logo key ([image: ]) on their keyboard. It was easy enough to find the Windows Desktop, but they were lost without knowing the [image: ] key will always bring them back to the Metro Start Screen.


  Let's face it. Most people don't like to change. I've seen people freak out because Favorites showed up in the Navigation pane of Windows 7 Explorer. "How do I get rid of it?" If a minor change such as that causes turmoil, you can imagine the controversy associated with the Metro Start screen. (For those who hate that Favorites feature in Windows 7, Windows 8 has added the option to turn Favorites off in the Navigation pane of Windows 8 Explorer. Of course, you're probably going to hate the new ribbon menu system for Window Explorer. See "Windows Tips and Tricks" in this issue.)


  The second reason that people are misunderstanding Windows 8 is that many Windows users are tired of Microsoft releasing new operating systems. They have new OS fatigue. They are happy with their Windows 7 (or Windows XP—and in some cases Windows Vista) and don't see a need to change. Windows users don't want to get hit with another upgrade charge.


  The much less expensive Apple Mac OS X is often cited as a reasonably priced operating system. The upgrade to OS X Lion is only $29.99. If you don't have Snow Leopard, then it will cost you about $60 to upgrade. However, it should be noted that Apple has released a new version of OS X almost every year since 2002. You may get charged less by Apple, but it's more often. It hardly seems a good comparison.


  When Windows 8 is released this year it will have been three years since Windows 7 entered the market. Perhaps Microsoft will do something shocking such as offer a cheap upgrade, or even better, release a Service Pack for Windows 7 which will include the faster Windows 8 kernel. I won't hold my breath.


  If you like Windows 7, then I don't think you have anything to fear. Nor, unless you see something you really like in Windows 8, will there be a compelling reason to upgrade. Microsoft will most likely continue to offer Windows 7 as an option and continue to support it well into the future. Windows XP will continue to get support at least until April 2014—13 years since it was first released. I don't think Microsoft will do much less for Windows 7.


  The third reason Windows 8 is misunderstood is many people flat-out want Microsoft to fail—especially Mac fanatics. This is a bit ironic, since many of them spent their time pointing out how the Microsoft lovers were so wrong (and they were) when they predicted that iPad would fail. Now some of those same Apple supporters find themselves making similar doomsday predictions for Windows 8. They may be right, but their opinions appear to be based more upon wishful thinking then any particular facts. That means much of the information out there has to be taken with a grain of salt.


  I don't particularly care whether Windows 8 succeeds or not. I'm fine with Windows 7. Yet, I have taken the time to look closely at Windows 8 and how it works. My goal is to clear up any misunderstandings while highlighting the strengths and weaknesses of the new Microsoft operating system.


  Understanding Windows 8


  There are a couple to key concepts that are important to understanding Windows 8 and how it works. The first is that the operating system includes two independent (yet integrated) interfaces: the Metro UI and the Windows Desktop. The Metro UI is designed for a touchscreen (although it works almost as well with a mouse) and has it own apps. There is no doubt that Microsoft had tablet computers in mind when designing the Metro UI. The other interface, the Windows Desktop, is essentially Windows 7 (without the Start Menu) operating in the same manner as other Windows versions and running Windows programs.


  The two interfaces (Metro UI and Window Desktop) do interact in some important ways, but they are mostly separate platforms for running Metro tablet-like apps and traditional Windows programs respectively—which usually do not interact with each other.


  The Metro Start Screen


  The Metro Start screen, as shown in Figure 1 above, is the first screen that you encounter after logging in. It looks and operates as you would expect a tablet computer to work. It also operates pretty much as you would expect with a mouse. Metro has its own apps and an app store for downloading more (see Figure 2).
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    Figure 2. Microsoft will offer apps to run in the Metro UI independently of the Windows Desktop.

  


  When an app is run by clicking on its tile (or touching the tile on a touchscreen), it consumes the entire screen (see Figure 3). (The [image: ] key will return you to the Start screen.) These apps run independently of the traditional Windows Desktop and it's quite possible that some Windows 8 tablets will not have Windows Desktop enabled at all.
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    Figure 3. There are no windows in the Metro UI (except in the Windows Desktop app). Each app takes up the entire screen.

  


  The Windows Start Screen


  The Windows Desktop runs like an app by clicking the Desktop tile in the Metro Start screen. (Circled in red in Figure 1 above.) This opens the Windows Desktop which looks and acts almost exactly like Windows 7 with a couple of notable exceptions. There is no Start Menu and Windows Explorer now has a ribbon menu system (see Figure 4).
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    Figure 4. The Windows 8 Desktop looks like Windows 7 except it does not have a Start Menu.

  


  The Desktop can be personalized with themes just as they are in Windows 7. (Windows Aero 3D seems to have been dropped. That doesn't bother me since I never use it.) All the same Windows 7 Gadgets can be added to the Desktop, although they will not appear in the Metro Start screen.


  The Start Menu has been replaced by the Metro Start screen ([image: ]). This is a bit of an inconvenience for people who make extensive use of the old Start Menu on the Taskbar, but there are ways to accomplish all the same Start Menu feats with the Metro Start screen. See "Windows Tips and Tricks" dated March 16. It did take a little time to learn these techniques (particularly finding programs and searching files), but overall it wasn't "all that bad."


  The ribbon menu in Windows 8 Explorer is new. The ribbon puts in view many of the needed options which have always been hidden or obscured in older versions of Windows Explorer (see Figure 5). For those people who prefer that the options be hidden, the ribbon menu can be quickly minimized. Windows 8 File Explorer is demonstrated in this week's "Windows Tips and Tricks."
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    Figure 5. The new ribbon menu in Windows 8 Explorer displays more of the most used features.

  


  My study of the new Windows Explorer showed benefits, but I have no doubt that it will be a major source of annoyance and aggravation for many people who don't like the change.


  I installed a number of Windows programs, including the Windows Live Essentials for Windows Live Mail, in the Windows Desktop without problems. Metro already includes an e-mail app, but it is limited in function (like a tablet app) and does not interact with the Windows Desktop functions such as Mail To. Another Windows e-mail program (Windows Live Mail or your choice of Windows e-mail programs) was needed for that.


  When conducting a search ([image: ]+Q) for e-mail programs both applications appeared (see Figure 6). The first runs in the Metro UI while Windows Live Mail opens the Windows Desktop to run.
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    Figure 6. Searches of programs, files and settings is done in the Metro Start screen. The search is activated by tapping any key on the keyboard. (The touch keyboard as shown here will only appear in the Metro UI when there is a touchscreen or device implemented.)

  


  While the touch keyboard appears in Figure 6, it will only display when you have a touchscreen available. However, you can set the Windows Desktop to display the touch keyboard and check out the options. See last week's "Windows Tips and Tricks."


  Windows Live


  Windows Live, the Cloud services from Microsoft, are integrated into the Metro UI. When I first set up Windows 8, it linked with a Live account I had activated long ago. Surprisingly, it immediately began reminding me about birthdays and when to put out the trash. I haven't used the account in years. There are other Cloud apps, such as SkyDrive, that were immediately available in the Start screen—where I found the test files I had added when I was writing now dormant "Windows Tips and Tricks" columns.


  Installing Windows 8 Consumer Preview


  Since I didn't have an old computer available, I installed Windows 8 in Virtual Box on a Windows 7 computer. That way there would be no interference with the Windows 7 installation. Digital Dave offered some cautions about installing Windows 8 in his column last week.


  Semi-Final Evaluation of Windows 8


  I can't give a final evaluation until Windows 8 is released and I get a chance to look at the final product. (Even then I will hedge, pending changes to Windows 8.) I can say that I won't be buying it on its first day out. I don't need it. At the same time, if it is installed on a new computer that I'm considering buying, I won't avoid it either. I've already gone through the initial learning curve and the shock is over for me. (Minimizing shock is what this series of Windows 8 articles and columns is all about.)


  One major advantage that may come with Windows 8 on a desktop or laptop is the library of additional apps available for the Metro UI.. (Maybe the library is sparse right now, but developers are taking an interest.) Many of these will be free and very easy to use. I got lost while fooling around with an app called Physamajig—an educational program for building objects and releasing them in a gravitational environment. Maybe that's a reason for not getting Windows 8.


  I am interested to see the new Windows 8 tablets which will be coming out. I want to know how they stack up against my iPad. I don't think they will be "all that bad." One plus that I can see is if the Remote Desktop app works as advertised, a person will be able to view and work from a tablet with their Windows Desktop on a remote computer.


  Does it matter to a computer user whether their desktop computer interface looks and works the same way as their tablet? Probably not. But some people will like that benefit. I have no idea if this all-in-one strategy of using one operating system for both tablets and desktops will work out for Microsoft. That depends upon the decisions of hundreds of millions of users. I know I was certainly skeptical when I first started looking at Windows 8. Now, I think that Microsoft may just pull it off. After all, it's not all that bad.


  New Windows 8 E-Book


  [image: ]The columns and articles that I've written over the last month have been updated, reorganized, and combined into a new e-book, Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8. This has been done for the convenience of anyone who wants this entire Windows 8 review series of articles and columns in e-book form. (It also includes as part of his Foreword for the book the two Windows 8 letters answered by Digital Dave last week.) You can take it with you or lend it to your friends. (It is not copy protected so it can be read on any device or converted to other formats.) It is available at our ComputorEdge E-Books site in both EPUB format for iPad, NOOK and your computer or MOBI format for Amazon Kindle. If you prefer, you can get the e-book directly from Amazon, which is generally more convenient for Kindle owners. If you have friends that you think would like to know a little more about Windows 8, please let them know about this new e-book.

  


  Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in the process of updating and compiling his hundreds of articles and columns into e-books. Currently available:


  Just released and available from Amazon, Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8!


  Available exclusively from Amazon, Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using Windows 7!


  Now available, the four book Windows 7 Secrets Essential Bundle (includes the primary tools or Windows 7, the Desktop, Start Menu, Windows Explorer and Taskbar (e-books listed individually below):


  Windows 7 Secrets Essential Bundle (EPUB for iPad, NOOK, etc.)

  Windows 7 Secrets Essential Bundle (MOBI for Amazon Kindle)


  Or individually:

  

  Windows 7 Desktop Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Desktop Secrets (MOBI for Amazon Kindle)


  Windows 7 Start Menu Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Start Menu Secrets (MOBI for Amazon Kindle)


  Windows 7 Explorer Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Explorer Secrets (MOBI for Amazon Kindle)


  Windows 7 Taskbar Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Taskbar Secrets (MOBI for Amazon Kindle)


  Sticking with Windows XP—or Not? (EPUB for iPad, NOOK, etc.)

  Sticking with Windows XP—or Not? (MOBI for Amazon Kindle)
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        Windows 8 Tips and Tricks: The Window Explorer Ribbon Menu
“The New Look of Windows 8 File Explorer” by Jack Dunning
      
    

  


  
    If you don't like the new Metro Start screen in Windows 8, you may find the ribbon menu in Windows Explorer equally distasteful. Let's have a look.
  

  


  If you don't like the Metro User Interface, then you may really hate the new Windows 8 File Explorer—especially if you can't stand the ribbon menu that Microsoft has added to all of its products. Other than the disappearance of the Windows Start Menu (now taken over by the Metro Start screen), the new Windows Explorer is the most dramatic change on the Windows side of the operating system.


  Windows Explorer is by far the most important tool in the Windows arsenal. It is used to find and open files, open Control Panel tools, launch programs, copy and move files, organize hard drives, and much more. The structure of the Windows Explorer menu was changed in Windows 7 and Vista, but a tap of the ALT key would bring the old XP menu back in view. That is no longer the case in Windows 8. Why does Microsoft have to mess with things?


  I've only occasionally used programs with ribbon menus, so as I reviewed the new Explorer, I was also learning about the ribbon. This gave me an opportunity to evaluate both Windows 8 Explorer and the usefulness of the new menu interface without a pre-existing notion. As I dug deeper into the capabilities of the new Explorer, I slowly came to realize that there was means in this madness. It is a system that can be individually adapted to each person, potentially configured in such a way that best fits the computing preferences of each user. If you want all the menu labels in view, you can have it. If you prefer minimized to small square icons, each of which carry their specific menu behind them, while the ribbon is hidden, then you can have that.


  While different from what many users have grown accustomed, the Windows 8 Explorer ribbon menu system offers more visibility of options and quicker access—usually saving at least one click. Plus many of the features we once accessed via the Start Menu (or other obscure methods) are just as easy to reach with Windows Explorer. For example, Computer Management, which is a collection of many of the important system tools such as Task Scheduler and Device Manager, is now a button on the Computer ribbon tab in Windows 8. Even in Windows 7, it was difficult to find Computer Management unless you knew that it existed and just where to look (usually I would search "manage" in the Windows 7 or Vista Start Menu search field).


  I'm guessing that there will be a good bit of hostility toward the changes in the new Windows Explorer. However, in the long run, I feel it is a change for the better. You can see for yourself and make your own determination.


  Windows 8 File Explorer


  Open Windows Explorer with the [image: ]+E key combination (works in both the Metro Start screen and Windows Desktop mode), or click the Windows Explorer tile on the Metro screen. If you're already at the Windows Desktop, you can click the Windows Explorer icon (looks like a group of folders) in the Taskbar. Explorer will open in the Computer mode, as shown in Figure 1. The Control Panel and other system controls are immediately available in the Computer tab of the Computer Windows Explorer window.


  
    [image: ]


    Figure 1. When first opened, Windows 8 Explorer displays the Computer tab of the Computer window. From this view the Control Panel can be opened, as well as, other system functions.

  


  Note that the ribbon menus display both icons and text. Most of the figures in this column have been resized smaller causing some of the text labels to disappear. However, in normal use, both text and icons will be visible at all times. The advantage to offering both the control icons and the text labels is that the icons are easy to recognize on the ribbon and the text tells you what they do—lest you forget.


  The File Menu


  The File menu breaks with the ribbon menu design and offers a standard drop-down menu which appears to be consistent regardless of the type of folder or file selected. What is significant is that additional features previously not found in Windows Explorer are immediately available, including the command prompt, Windows PowerShell, deleting history (recent places and address bar history), and Frequent Places (see Figure 2). (Frequent Places is hidden by the command prompt secondary menu.)
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    Figure 2. The File menu of Windows 8 Explorer appears to be standard across all Windows operating systems offering Frequent Places (hidden under Open command prompt in this image), the command prompt and PowerShell.

  


  In Windows 7, the command prompt and Windows PowerShell would be found under All Programs => Accessories in the Start Menu. Now that the Start Menu is gone in Windows 8, Explorer has taken over at least this portion of the work. (To view all of the Metro apps and Windows programs available, return to the Metro Start screen ([image: ] key), then press CTRL+TAB simultaneously.)


  The View Tab Menu


  Everything which appeared in the old Windows Explorer View menu is now available, and simultaneously in view, in the View tab of the ribbon (see Figure 3). In fact some features, such as Show/Hide "Hidden items" and "File name extensions", appear when a folder/file is selected (see Figure 9 and Figure 10 below). Previously, these were changed with the Properties menu (right-click).
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    Figure 3. The View tab of Windows 8 Explorer puts all of the layout options in view. For quick changes between the Details view and the Large icon view the two buttons in the lower right corner are available at all times regardless of the tab selected in the ribbon or the type of folder/file.

  


  Viewing panes can be selected, but now, in addition to the Navigation Pane, there is only the option of either the Preview Pane or the Details pane—not both. The usual Layout options (thumbnails and details) are easily deciphered from the icons. The two layout buttons in the lower right corner are a plus. One equates to the Details layout while the other is Large thumbnails (icons). The advantage to these two buttons is that they are always available regardless of which ribbon tab is selected, making switching between the two layouts a snap (...or click).


  Special Ribbon Tabs


  Windows 8 Explorer changes the ribbon tabs available depending upon the type of folder or feature viewed. In this case the special functions Disk Tools (Drive) has been added to the Menu (see Figure 4). When a drive is selected, the Drive tab offers those features formerly available through the Properties window (right-click). The command for safely removing USB drives also appear on this menu.
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    Figure 4. In the Computer view of Windows 8 Explorer a special Disk Tools tab is made available.

  


  These special ribbon tabs are tailored to the specific type of folder. Pictures, Music and Videos folders offer this extra tool tab with the tools appropriate for each (see Figure 6). The Picture Tools tab only appears when the folder type is Pictures. In the Picture Tools tab images can be rotated left or right, viewed in a slide show (right-click on images for slide show controls after show starts), set as background, etc. There are similar functions for Music Tools and Video Tools in their respective folder type. To change the folders type select the folder, then open the Properties window from the Home tab in Windows Explorer and use the Customize tab.
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    Figure 5. In Windows 8 Explorer the Picture Tools in a Pictures type folder offers limited editing and viewing functions.

  


  The Share Tab


  A Share tab will appear also when an appropriate folder type is selected (see Figure 7). Sharing features include printing, faxing, burning to disc, e-mail, zip compression and Homegroup. Homegroup is the network sharing systems first introduced in Windows 7. It supports Windows 7 and Windows 8 computers.
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    Figure 6.The Sharing tab in Windows 8 Explorer offers tools for e-mailing, printing, faxing and Homegroup.

  


  Search Tools


  The Search Tools tab does not appear until the search field is selected by clicking the left mouse button when the cursor is hovering over the search field. All of the advanced search functions (which are a little more cryptic in Windows 7) are in view and ready to use (see Figure 7).
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    Figure 7. Windows 8 Explorer Search Tools puts all of the search functions in clear view.

  


  This is an improvement over both Windows 7 and Vista. Vista included Advanced Search options and Windows 7 allows selection of options directly in the search field. In the Windows 8 ribbon the advanced search options are buttons always available for easy access.


  Keyboard Option for the Ribbon Menu


  In previous versions of Windows Explorer, if the old XP menu bar (File | Edit | View | Tools | Help) was not in view, the ALT key would pop it up. Now pressing the ALT key turns the keyboard into hot keys that will activate the labeled parts of the ribbon menu (see Figure 8). (The classic Windows menu bar seems to be retired.)
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    Figure 8. In Windows 8 Explorer pressing the ALT key will display hot labels for the various tabs. Hit the assigned key and the next set of hot labels will appear in the appropriate place.

  


  For example, after pressing the ALT key, the V key will select the View tab from the ribbon menu. The View tab will then display another set of hot keys for selecting the functions within the View tab. This is exactly the same as a point and click except you use the keyboard rather than the mouse.


  Quick Access Toolbar


  Windows 8 also includes a Quick Access Toolbar (circled in red below the ribbon menu in Figure 9) which only displays a single square icon for the included functions. By default these single click hot buttons include: Undo, Redo, Delete, Properties, New Folder and Rename. This toolbar can be set to appear above or below the ribbon. While you can remove all of the buttons from the toolbar, I did not see a way to remove the toolbar itself. (There is always someone who wants to make features completely disappear.)
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    Figure 9. The Quick Access Toolbar in Windows 8 can include functions from any of the ribbon tabs.

  


  However, you can completely bypass the ribbon by adding ribbon menu functions to the Quick Access Toolbar. Right-click on the name of a feature in the selected tab and click Add to Quick Access Toolbar. The feature will now be added to the Quick Access Toolbar in the form of another small square icon button. Clicking that button will access the feature without affecting the display of the ribbon. (For the reverse, right-click on the new button to remove it from the toolbar.)


  If you want an even more minimalist view of Windows Explorer, you can right-click on either the ribbon or the toolbar and check Minimize the Ribbon. (You can also click the little arrow in the upper right corner next to the Help question mark.) This will cause the features of the various tabs to disappear leaving only the tab names visible at the top. Clicking the tabs will continue to temporarily open the ribbon view for each tab. To bring back the permanent ribbon reverse the process with the same right-click and uncheck Minimize the Ribbon.


  Resizing the Ribbon Menu


  For readability I resized the Windows Explorer window smaller for the screen shots. This left the text as readable as possible. However, as the Windows Explorer window is made smaller, text and graphics will disappear from the ribbon. This is fine if you remember the purpose of each icon, but not so good if you have trouble with mere images. Figure 10 shows what is lost by resizing the window to a smaller width. If you click on the little down arrow in each section the original options will temporarily appear.
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    Figure 10. When the Windows 8 Explorer window is reduced in width, the ribbon automatically reduces the space required by collapsing the option boxes. In red are the lost options, although they pop up when the reduced box is clicked.

  


  It most situations, you should be able to size the Windows Explorer window wide enough to see all of your options, making your selections easier.


  The Three Key Features from Windows 7


  The Navigation pane in Windows 8 includes the three key Windows 7 features: Favorites, Libraries and Homegroup. Favorites is for shortcuts that you use frequently. Libraries is a system for collecting similar types of folders and files together whether on your computer or over a network. Homegroup is a sharing system between various computers available in Windows 7 and Windows 8 (see Figure 11). For more detailed information about these the features see the e-book Windows 7 Explorer Secrets available at ComputorEdge E-Books, Amazon.com, and iTunes.
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    Figure 11. Windows 8 Explorer supports three key features of Windows 7: Favorites, Libraries and Homegroup. Favorites can be removed from the Navigation pane by unchecking Show favorites.

  


  I use Favorites extensively, but if you want to remove it from the Navigation pane, uncheck Show favorites from the drop down menu.


  My Windows 8 Explorer Conclusion


  This is the most exhaustive look I have ever taken at a ribbon interface. It's easy to sit back and complain about how Microsoft changes things, but you don't get an appreciation for the issues involved until you force yourself to experience something first hand.


  After mucking around in Windows 8 Explorer a good bit, I've come to the conclusion that it's not all that bad—maybe even good. The changes in Windows Explorer were made for a reason. I like the way that virtually everything I do is only a click away—two clicks at the most. The same things can be done in other versions of Windows (often in multiple ways), but sometimes a right-click is required, other times I need to dig through various menus and windows, and still other times a search is the answer. While no menu system is perfect, the Windows 8 Explorer ribbon menu and Quick Access Toolbar seem to optimize the balance between functionality and ease of use. Once you get used to it (some people never will) and tailor it for your personal use, I think you might like it.

  


  Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in the process of updating and compiling his hundreds of articles and columns into e-books. Currently available:


  Just released and available from Amazon, Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8!


  Available exclusively from Amazon, Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using Windows 7!


  Now available, the four book Windows 7 Secrets Essential Bundle (includes the primary tools or Windows 7, the Desktop, Start Menu, Windows Explorer and Taskbar (e-books listed individually below):


  Windows 7 Secrets Essential Bundle (EPUB for iPad, NOOK, etc.)

  Windows 7 Secrets Essential Bundle (MOBI for Amazon Kindle)


  Or individually:

  

  Windows 7 Desktop Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Desktop Secrets (MOBI for Amazon Kindle)


  Windows 7 Start Menu Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Start Menu Secrets (MOBI for Amazon Kindle)


  Windows 7 Explorer Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Explorer Secrets (MOBI for Amazon Kindle)


  Windows 7 Taskbar Secrets (EPUB for iPad, NOOK, etc.)

  Windows 7 Taskbar Secrets (MOBI for Amazon Kindle)


  Sticking with Windows XP—or Not? (EPUB for iPad, NOOK, etc.)

  Sticking with Windows XP—or Not? (MOBI for Amazon Kindle)
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        Wally Wang's Apple Farm
“Say Good-Bye to Print” by Wally Wang
      
    

  


  
    Say Good-Bye to Print; Security Running OS X as a Virtual Machine; The Delusions of Research in Motion; The Strange Business of Google; More News About Foxconn; The Hunger Games Apps; TinkerTool.
  

  


  Encyclopedia Britannica has announced they will no longer sell printed editions of their encyclopedias, although they'll still maintain an online version. According to InvestorPlace, the company only sold 8,000 copies of their encyclopedias in 2010 compared to 1990 when they sold 120,000 copies. When a set of encyclopedias costs over $1,000, why buy something that's immediately obsolete, bulky and incomplete? InvestorPlace says we can learn two lessons from the fate of printed encyclopedias:


  "Lesson One: No product is impervious to change.

  Lesson Two: A company that adapts to changing market forces can survive."


  The business of selling printed sets of encyclopedias is gone forever whether you like it or not. If printed encyclopedias are obsolete, other types of books won't likely be far behind. How many people still rely on the telephone directory to look up somebody's phone number compared to just ten years ago?


  Curiously, one field of publishing taking advantage of e-books are erotic novels. Holding and reading an erotic novel in public might be intimidating, but when you're reading an e-book on a Kindle or iPad, nobody can see what you're reading, which makes erotic novels safer to read in public according to MarketWatch.


  One of the first e-book success stories is Fifty Shades of Grey by E.L. James, which is a love story involving bondage. Despite this strange topic, it has become an underground e-book bestseller that has now crossed over into actual print.


  On a more positive note, a group of technology companies and textbook publishers, dubbed LEAD (Leading Education by Advancing Digital), are promoting digital textbooks, which they claim could potentially "save schools about $250 per student per year, adding up to over $12.2 billion per year if fully implemented. If all or almost all of the US's 49-50 million K-12 students were to be equipped with digital textbooks, the quality of the textbook education would significantly improve (along with other less-tangible benefits such as an expected lowering of the dropout rate and improved test scores) and the cumulative savings would be substantial: over $12 billion per year. Although the US spends more than $7 billion annually on traditional textbooks, many students are still using books that are seven to 10 years old and often contain outdated material, the commission said. Other countries, such as South Korea, may gain a further competitive advantage over the US by transitioning to digital textbooks more quickly."


  With rapid changes in information, traditional textbooks are just as outdated and incomplete as encyclopedias. To force students to use obsolete textbooks is no better than forcing kids to use obsolete encyclopedias instead of the Internet to do research.


  Printed materials are obsolete. Sears no longer can afford to print and mail massive catalogs to potential customers because those bulky, heavy catalogs can't compete against a Web site that can offer more and adapt to change rapidly. Anyone relying on print, such as the postal system, is already getting hurt.


  Ordinary print publishers are going to get hurt next. As the largest book distributor, Amazon is starting to demand deeper discounts or they'll refuse to sell certain books. As a middleman between the authors and the distributors, print publishers have little bargaining power so they either give in to Amazon's demands for steeper discounts or they lose sales through Amazon. In the meantime, authors are finding it's faster and more profitable to self-publish through Amazon, Barnes & Noble, or Apple. With self-publishing, you completely circumvent the gatekeeper mentality of the publishing industry and appeal directly to potential readers and customers, all while earning greater royalties per e-book while retaining the rights to your work at the same time.


  With Amazon holding approximately 60 percent of the e-book market, Barnes & Nobles holding another 30 percent and Apple holding 10 percent, the clear leader is Amazon. The only chance Apple has to catch up is through their iBooks Author program that allows the creation of interactive e-books that run on the iPad. When Amazon introduces their own interactive e-book standard, that should cement Amazon's stranglehold on the book industry that the print publishers can never reverse.


  If you think print has a future, forget about it. Everything's going digital and the sooner people embrace this new reality, the sooner they'll thrive under these new rules. Mourn the loss of print if you must, but if you refuse to embrace the new realm of digital information, good luck clinging to your outdated fantasies. Anyone still believe the benefits of clay tablets will always outweigh the benefits of using paper? If so, then you might as well argue that the benefits of paper will always outweigh the advantages of digital e-books.


  Security Running OS X as a Virtual Machine


  If you use a program like Parallels, you can run Windows, Linux, or any operating system as a virtual machine. With the latest version of Parallels, you can now even run OS X as a virtual machine, which means you can have your main copy of OS X Lion running as the host operating system with a second copy of OS X in a virtual machine.
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    Figure 1. Parallels can turn OS X into a virtual machine.

  


  Parallels can turn OS X into a virtual machine because OS X Lion creates a separate recovery partition on your hard disk. That way if your copy of OS X somehow gets wrecked, your Macintosh can restore the OS X operating system back through this recovery partition.


  Parallels simply tricks your Macintosh into reinstalling the OS X operating system inside a virtual machine. Once you have OS X Lion installed, you can sign up as an Apple Developer and download the beta version of OS X 10.8 Mountain Lion. Now you can test Mountain Lion within a virtual machine in Parallels.
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    Figure 2. Installing OS X 10.8 Mountain Lion in a virtual machine on a Macintosh.

  


  With two copies of OS X running, don't expect your Macintosh to run as quickly, but virtual machines give you a safe way to browse the Internet without putting your main operating system at risk from malicious software such as Trojan horses or worms. For maximum protection, just run Linux or OS X in a virtual machine and browse the Internet using this virtual machine.


  For those still worried about the possible threat of Trojan horses and worms on the Macintosh, grab a free copy of Sophos Anti-Virus for the Mac. Since most dangers come from the Internet, grab a copy of AVG's LinkScanner for Mac. LinkScanner highlights each link on a search page to let you know how safe the program thinks each link might be. By avoiding unsafe or suspicious links, you can avoid the majority of problems on the Internet.
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    Figure 3. LinkScanner can examine links before you visit them.

  


  With the next version of OS X 10.8 Mountain Lion, Apple is also introducing GateKeeper, which tries to keep you safe on the Internet. While nothing can be completely safe, OS X still faces far fewer threats than Windows. For the truly paranoid, combine GateKeeper with LinkScanner and Sophos Anti-Virus for Mac along with running another operating system in a virtual machine and you can greatly minimize any threat targeting your computer. Just don't rely on technology to protect you when your own gullibility is the main cause for spreading malware among all computer users.


  The Delusions of Research in Motion


  It's hard to believe that Research in Motion's Blackberry smartphones dominated the market just five years ago where Apple's iPhone had zero share of the market. Now Reuters reports that Research in Motion plans to pull back from the consumer market and focus on the business market. Of course, the business market is now moving towards letting employees pick what they want to use and people tend to pick their favorite consumer items, which is exactly the market Research in Motion is abandoning.


  Amazingly, Research in Motion believes they can compete with the introduction of new Blackberry 10 phones by the end of the year. What will these new Blackberry 10 phones offer? The QNX operating system. What will the QNX operating system do better? Figure that one out and you can figure out Research in Motion's latest hope hinges on introducing something new with no clear benefits outlined for anyone.


  In technical terms, QNX was designed for embedded systems so it's reliable and stable while also being fast and small. That's a great foundation, but unless Research in Motion finds a way to make the QNX operating system offer some fantastic new features for the average person, just pinning their hopes on technical features makes no sense if consumers can't see a massive benefit in return. Technically, OS/2 was more advanced and reliable than Windows, yet none of those technical advantages mattered to the general public.


  Research in Motion's steady decline in the face of change simply illustrates the fate of anyone or any organization that coasts on inertia without constantly adjusting to reality. Research in Motion can join Kodak, Montgomery Wards and Palm Computing as examples of how to ignore new opportunities while pursuing solutions that no longer work.


  The Strange Business of Google


  When Google released Android, they tried to take market share away from the iPhone. While they succeeded, it may have cost them more than what it's worth. According to The Guardian, Android may have generated up to $550 million for Google while Google's Maps and Search on the iPhone may have generated up to four times that revenue. Given the huge amount of money Google earns indirectly from the iPhone, why did they bother releasing Android?


  Toss in patent infringement lawsuits from Oracle and Apple combined with patent royalty payments to Microsoft for every Android device sold, and the cost of using Android keeps growing. By competing against the iPhone, Google risks cutting off their own source of revenue while replacing it with the much smaller revenue generated by Android. If Apple simply shifts from reliance on Google to someone else, there goes Google's revenue stream in return for the headache of trying to keep Android competitive.


  Most people try to work less and make more money. Google is trying to work harder and make less money. If Google continues down this path of self-destruction, they may soon join Research in Motion as yet another example of corporate clumsiness and short-term incompetence.


  More News About Foxconn


  Anti-Apple critics love to point out that Apple's supplier, Foxconn, exploits its workers while completely ignoring the fact that other technology companies like Intel, Dell and Microsoft also rely on Foxconn to produce their own products. Earlier this year, Foxconn workers producing Microsoft's Xbox reportedly threatened mass suicide, although few people blamed Microsoft in the same way that they attack Apple for the exact same allegations.


  In response to claims that they overworked their employees, Foxconn has cut back hours. Now many workers at Foxconn are complaining about earning less money through their reduced working time. If these people were truly overworked, wouldn't they be happier to get more time off?


  Forbes reports that many of Foxconn's supposedly overworked employees are interns, who actually get paid more than interns working for American companies. Many interns in Western companies actually work for free just for the experience, yet if they worked at Foxconn, they would get paid to earn their experience as well. So instead of attacking Foxconn and blaming Apple for all of Foxconn's problems, perhaps people should really be attacking other technology companies for their role in supporting Foxconn, and for exploiting interns in their own countries by not paying them what Foxconn interns make.


  Earlier this year, people lined up to get a job at Foxconn because a Foxconn job actually paid more than other types of work elsewhere. If people are going to claim that Foxconn exploits its workers, why not attack the rest of the Chinese economy for not paying as well as Foxconn? If people willingly line up to apply for a Foxconn job, that means conditions in other parts of the country must be even worse. So why are people only complaining about Foxconn unless, of course, it's the only way critics can find to complain about Apple (while ignoring criticism of any other company that does the exact same thing that Apple does)?


  The Hunger Games Apps


  The Hunger Games movie remains popular in the theaters while the book continues hitting the best seller lists. If you liked either the book or the movie, then you might be interested in several apps designed around the book trilogy.


  First, there's the Hunger Games: Girl on Fire app that's free. In this game, you play the role of the heroine, Katniss, trying to survive in her futuristic world.
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    Figure 4. The Hunger Games: Girl on Fire game lets you guide the heroine to safety.

  


  If you enjoy trivia, you might want to pay 99 cents to download the Hunger Games—Tidbit Trivia app, which provides interesting background information about the story's origins and inspiration. Of course, you could simply buy the Hunger Games Trilogy and read the whole thing for yourself. That way you don't have to wait until Hollywood releases the sequels to find out how it all ends.


  



  
    ***
  


  To modify your Macintosh, you can click on the Apple menu and choose System Preferences. However, if you download the free TinkerTool program, you can modify settings that the System Preferences window won't let you change.
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    Figure 5. TinkerTool lets you adjust settings normally hidden from view.

  


  For example, you can turn off the "connect to server" feature, disable animation effects when opening files in the Finder, and allow the Finder to display hidden files. If you don't like the three-dimensional glass effect of the Dock, turn it off. If you share a Macintosh with others and don't want them to modify icons on the Dock, TinkerTool can block anyone from changing the Dock.


  For those who like to tinker around with settings to truly customize their Macintosh, TinkerTool gives you the access you need in a friendly user interface so you don't have to type arcane and cryptic commands. For most people, TinkerTool may be unnecessary, but for those people who can't resist toying around with every possible feature, TinkerTool can satisfy your craving for more power without sacrificing the ease of use associated with the Macintosh.

  


  In the early days, before Wally became an Internationally renowned comedian, computer book writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer dangling participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.


  Wally is responsible for the following books:

  

  My New Mac, Lion Edition

  My New iPad 2

  Steal This Computer Book

  Microsoft Office 2010 For Dummies

  Beginning Programming for Dummies

  Beginning Programming All-in-One Reference for Dummies

  Breaking Into Acting for Dummies with Larry Garrison

  Strategic Entrepreneurism with Jon and Gerald Fisher

  How to Live with a Cat (When You Really Don't Want To)

  The Secrets of the Wall Street Stock Traders

  Mac Programming For Absolute Beginners

  99% Fairy Tales (Children's Stories the 1% Tell About the Rest of Us)

  The Zen of Effortless Selling with Moe Abdou

  The 15-Minute Movie Method


  In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15 Minute Movie Method." Wally can be reached at wally@computoredge.com.
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        Beyond Personal Computing
“Those First Jobs in the High-Tech Industry” by Marilyn K. Martin
      
    

  


  
    Amusing anecdotes about the difficulties of getting started in the high-tech industry.
  

  


  Lots of young people today, raised with computers, smartphones and video games, want to get into the high-tech industry when they get out of school. Dot-coms and start-ups are very attractive since they can be pretty laid back with a hacker ethos, especially if their workforce is toiling for pennies and stock.


  But computer security firms are deadly serious with more stuxnet on the horizon, and everyone wants to corral the ever-expanding cloud-mass of mined data and figure out how to make money with it. Even successful social media start-ups eventually embrace a more corporate structure for a larger global reach. So getting started in the high-tech industry may not be the slam-dunk some students think.


  Intern Jobs


  Usually unpaid, they are a great way for high school or even college students to spend summers working in high-tech companies they may want to have careers in someday. Basically just a company Go-fer, some interns are a little more ambitious. These are from interns' notes in tech firms' Suggestion Boxes:


  "Has anyone got more computer games to load into my cubicle's computer? I've aced every level of the ten games already in the computer. I rotate the screensavers and cursors every hour on the hour. It's getting harder to 'look industrious' between running errands and answering phones."


  "I know there must be a high quality scanner and photo-quality printer somewhere in this company. Can someone tell me where it is? I need some slightly different identification to get into the great bars around here."


  "My desk is too clean for anyone to take me seriously as the future CEO of this start-up. Can anyone loan me old projects, outdated reports or even a Rubik's Cube for my desk? Or even important looking memos to tack to the walls of my cubicle?"


  Job Application Bloopers


  Being a little too eager to impress a future high-tech employer can lead to all sorts of application strangeness. Try staying calm and reread your answers to avoid making these classical app boo-boos:


  • "Instrumental in ruining an entire Silicon Valley Start-Up." (Think he meant running?)


  • "Please don't misconstrue my 17 recent jobs as job-hopping. I have never quit a job." (STMI = Sharing Too Much Information)


  • "Experienced supervisor, defective with both newbies and seasoned professionals." (Effective?)


  • "I'm extremely loyal to my present tech company. So please don't let them know of my immediate availability."


  • "I designed a new software system at $3 million over-budget." (Perhaps he meant under?)


  • "Yes, I attended Stanford U. from August 1880 to May 1984." (And ... you're a Highlander?)


  • "My favorite hobby is donating blood. 14 gallons so far." (Do vampires run in your family?)


  Top Dozen Things Not To Say In A Job Interview At A High-Tech Company:


  12) Self-starter? Well, I could bring in my Darth Vadar alarm clock.


  11) Actually I'm more of a t-shirt, jeans and flip-flops kind of person.


  10) Do you pay overtime? Rounded up to the next hour?


  9) Do you order in better food than burgers and pizza? I love quality sushi.


  8) Foreign operations? Well, I don't fly. But there are always boats and trains, right?


  7) I'm useless without ten hours of sleep a night. So are you OK with me starting at 10 AM?


  6) Spreadsheets? Well, you know what they say: There are lies, damn lies and then there are statistics.


  5) Do you cover rental cars for collision? How about if I have a little driver's license problem, and need someone to drive me?


  4) Stanford taught me that working in teams is great for slackers.


  3) Acronyms? Well, yeah, sorta. I know what DUI and DOA mean.


  2) Two words: Family first. So I absolutely need all evenings and weekends off.


  1) Firing people? Yeah, I could do that. You got a tutorial?


  Push That Job Interview Over the Top!


  1) Oh yeah, I'm very responsible. On my last job, every time something went wrong, they said that I was responsible.


  2) Handle a variety of tasks? Heck, yeah! I've had ten different jobs in four months.


  3) Some PR experience? Sure! Last company I worked for got in serious legal trouble, and I got to go on TV to explain how the whistleblower died.


  Those Tricky Interview Questions


  Q: So where do see yourself in ten years?

  A: Well, it's Wednesday afternoon. So I guess on the links finishing my golf game.


  Q: If you looked out the window right now and saw a zombie army marching down the street to destroy this company, what would you do?

  A: I'd grab my trusty anti-zombie weaponry.

  Q: And where would you get those?

  A: Same place you got the zombie army.


  Q: So where did you receive your training?

  A: Yale.

  Q: Very good! And what's your name again, Mister ...?

  A: Yim Yohnson.


  Human Resources: The Parting Shots That Hurt


  "Well, young man, I see you've had no computer training. Although that qualifies you for upper management, you're under-qualified for our entry level positions."


  A young man had been hired, and was called into HR a few weeks later. "Young man," began the HR manager, "When you applied for this job you said you had 5 years experience. Now I discover that this is your first job. Ever. Can you explain?" The young man shrugged. "Well, your ad said you wanted someone with imagination."


  One HR Manager closed the applicant's interview with "And what starting salary are you looking for?" The young man didn't miss a beat: "In the neighborhood of $125,000 a year, depending on the benefits package." The interviewer nodded, then said: "How would you like a package offering six weeks of paid vacation, 25 paid holidays a year, full medical and dental, 75% company provided retirement, and a leased Porsche." The young man couldn't believe it. "Wow! Are you kidding?" The HR Manager smiled. "Yes. But you started it."


  Thinking Outside the Box


  A man applied for a job as a computer industry spy. Together with several other applicants, they were each given a sealed envelope and told to take it to the fourth floor. The man waited until the others left, stepped into an empty office, and opened the envelope. Inside was a message: "You're our kind of person. Report to Human Resources on the fifth floor."


  HR-Speak—and What They Really Mean


  "Entry Level Position in a Great Start-Up" (You'll be making minimum wage, and this company will be belly up in a year.)


  "Profit Sharing Plan" (Once the profit is divided among upper management, there won't be any profit left for you serfs.)


  "Join Our Fast Paced Company" (We have no time to train you. Introduce yourself to your new coworkers and ask them what to do.)


  "Casual Work Atmosphere" (We don't pay enough to expect professional dress. So bring on the earrings, tattoos, torn jeans and flip-flops.)


  "Duties Will Vary" (Anyone in the company can boss you around.)


  "Competitive Environment" (Lots of turnover, keep your resume in your pocket.)


  "Must Be Deadline Oriented" (You'll be six months behind schedule on your first day.)


  "Flexible Hours" (Work 40 hours a week, get paid for 25.)


  "Must Have An Eye For Detail" (We have no quality control.)


  "Problem Solving Skills A Must" (You're walking into a company in perpetual chaos.)


  "Requires Team Leadership Skills" (You'll have the responsibilities of a manager, without the pay or respect.)


  Sleepy Programmer in His First Meeting


  Sleepless, due to trying too hard to impress his new boss with his computer skills, a programmer fell asleep in his first conference room meeting. The frowning CEO decided to teach him a lesson. He had everyone else in the meeting file quietly out, then rounded up some people from other departments or off the street, and had them quietly take a seat at the conference table around the sleeping programmer.


  Then the CEO cleared his throat, which woke up the programmer. The grim CEO then told the programmer, "Bob, your plan is very, very risky. However, you've given us no choice but to try it. I only hope, for your sake, that you know what you're getting yourself into." Then everyone got up and left the room—except for the blinking, slightly panicked Bob.


  (Most of the amusing anecdotes can be found on multiple joke sites on the Internet. Special thanks to squarewheels.com, workjoke.com, broadcaster.org.uk and comedy-zone.net.)

  


  Marilyn is a freelance writer and humorist, with a special interest (besides computers and technology) in Science Fiction. A SF Horror story appeared in July 2011 in Deadman's Tome. And in January 2012 she had a SF Police Procedural appearing in Cosmic Crime magazine, and a SF Dystopian Romance appearing in the Strange Valentines anthology. She also has almost seventy articles on Helium.com, and is writing a humorous Young Adult SF series, Chronicles of Mathias. Volumes One and Two have received a "Gold Star for Excellence" from TeensReadToo.com, and are available from most on-line bookstores.


  ComputorEdge E-Books is now converting Marilyn's computer humor columns into e-books.


  The second book, Computer Hardware: "Parts Is Parts", is now available at our E-Book Store in both EPUB format for iPad, NOOK, etc., and MOBI format for Amazon Kindle.


  The first book, Computer Confusion in Paradise: Lo! And in the Beginning There Was Total Befuddlement!, is also available at our E-Book Store in both EPUB format for iPad, NOOK, etc., and MOBI format for Amazon Kindle.
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        Editor's Letters: Tips and Thoughts from Readers
“Computer and Internet tips, plus comments on the articles and columns.” by ComputorEdge Staff
      
    

  


  
    "Running a Network Command," "Thank You," "Getting E-Book from Amazon," "Apple OS X," "Views of Windows 8," "Canvas For Mac"
  

  


  Running a Network Command


  Digital Dave,


  netstat -an does not remain on the screen long enough to read the outcome. How can it solve this problem?


  -Rachel Townsend, Encinitas, CA


  [Try opening the Command Prompt first and running it in that window. (All Programs => Accessories => Command Prompt and type in netstat -an) —DD]


  Thank You


  I have been a fan since The Byte Buyer days and you have helped me a few times. I can't say enough about how useful and helpful you and the magazine are. Thank you and all the folks for their dedication to helping us novices.


  -Mike Barletta, Spring Valley, CA


  Getting E-Book from Amazon


  [Regarding the March 16 EdgeWord: Kindle E-Book Now Free on Amazon! column:]


  I tried to get your e-book to my PC from Amazon with no success. I have a Kindle reader on my PC, but Amazon say they can't find a registered device. My PC is running Ubuntu 10.04 and I have been using Calibre for my Kindle reader for a while. What is the deal??


  -Dennis, San Diego, CA


  [I'm not sure that Amazon has Kindle reading software for Linux. It's necessary to register any Kindle device (including software) from the device to your Amazon account. I don't think that you can register Calibre as a Kindle device. However, you should be able to use the Kindle Cloud Reader. —Jack]


  Apple OS X


  [Regarding Barry Fass-Holmes's March 16 article, "Intro to Apple Macintosh OS X":]


  Thanks for this. Even I could understand it!


  -Carolan Buckmaster, San Diego, CA


  This is a timely article for us because our son just gave us a Mac he no longer uses. I will definitely "bookmark" it and take notes to use while trying to learn to use the Mac. It's been difficult so far to get used to it after years with Windows. How do you find out what the "keychain" password is? I can't get a software update without it and our son doesn't remember what it is. We have the main password and it seems to be different than that one. I hope there's a place to change that password.


  Help and thanks!


  -Sandy, San Diego, CA


  Hi Sandy,


  Thank you for your comments on the article.


  Keychain Access, as you might know already, is a program built into Mac OS X that stores and lists the user's passwords for the operating system, for secure Web pages that you visit, etc.


  The Keychain Access program is located in the Utilities folder that is located in the Applications folder.


  I am reluctant to give you too much information about how to work with Keychain Access given that you are new to Mac OS X.


  In the Finder, please select Help from the menubar, type Keychain Access in the text input box that displays, and a list of related help articles will display.


  Also, here is a link to an Apple knowledge base article about resetting the keychain.


  After reading these articles, if you feel comfortable proceeding with making changes to your keychain, please make a backup of your Mac's hard drive (if you haven't done so already) using Time Machine and an external hard drive in case something goes wrong.


  Otherwise, I recommend that you visit an Apple Store and make an appointment with one of the Genius Bar's staff members. They should be able to help you to understand how to proceed.


  Hope this helps.


  -Barry Fass-Holmes, San Diego, CA


  Views of Windows 8


  [Regarding the March 16 Windows Tips and Tricks: Understanding Windows 8 Start Charm column:]


  I did not love Windows 8.


  OK, I downloaded it and found that my dial-up wireless Internet did not work on it. I created a new backup before I downloaded this file so I could do a restore. I spent four hours tooling around on Windows 8. It took me a half hour to figure out how to open Control Panel. I finally found it and looked around at the way things looked there.


  The thing I could not get used to is my mouse disappearing and hovering over an application and not really seeing the mouse pointer. I discovered that I did not like Win 8. As a matter of fact, I think Vista was better than this. It is sort of like Printmaster's new program. They took a great program and ruined it. Ease of use is everything.


  They forgot that they have two to 102 year-olds using this program and I could see my 88 year-old Uncle not being able to handle this. This is the first Beta that I hated—not even Vista bothers me. I still have a computer running Vista because I did not want to buy more software for it. I think Microsoft is about to make a big mistake on this one.


  [That's odd. I haven't experienced the disappearing mouse problem. I imagine that a lot of people are going to hate the changes in Windows 8. —Jack]


  -Melba Kalaher, Denver, CO


  Looks like Windows 7 will be as far as I get. The whole "charm" of Windows that made it so popular is that I can just point and click an icon to do something. Now you want me to start remembering "commands" again (key-strokes this time). I realize that this may work better on a tablet than my PC, but I'm 62 years old (yes, I remember DOS) and those little tablet screens don't work for me anymore.


  -Doug St.Martin, Colorado Springs, CO


  Many thanks for a very helpful article explaining the ins and outs of Windows 8's new Start Charm screen.


  The explanation is very clear and fills the void that I experienced upon first seeing this screen in Windows 8 developer preview.


  Another way of looking at this screen, from a Mac user's perspective, is that it mimics the Launchpad program that Apple introduced in Mac OS X Lion in July 2011. (Windows 8's rumored release date is more than one year later, in October 2012).


  Whereas Launchpad displays the actual icons of installed programs, Start charm displays tiles. Each tile is a single color with a white caricature of the represented program's function and/or white lettering. Launchpad's icons are a uniform size, Start Charm's tiles occupy varying amounts of space on the screen.


  Time will tell how much Windows 8 adopters benefit from this new feature.


  -Barry Fass-Holmes, San Diego, CA


  Canvas For Mac


  [Regarding the August 19 Worldwide News & Product Reviews column:]


  I've also run Canvas under Parallels and it's just OK. You have to buy four things: Windows, the app, the VM, ESET or Norton.


  Native Mac would be an order of magnitude better, but these folks are so ingrained in the Windows world, there is no hope.


  -Dan, Huntington Beach, CA

  


  ComputorEdge always wants to hear from you, our readers. If you have specific comments about one of our articles, please click the "Tell us what you think about this article!" link at the top or bottom of the specific article/column at ComputorEdge.com. Your comments will be attached to the column and may appear at a later time in the "Editor's Letters" section.If you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at ceeditor@computoredge.com. If you would like to review our recent e-books, please visit ComputorEdge E-Books.


  
    

    Send e-mail to ceeditor@computoredge.com with questions about editorial content.

    Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.

    Copyright © 1997-2012 The Byte Buyer, Inc.
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